# CONTENTS

Contents ........................................................................................................................................... 2

Introduction ...................................................................................................................................... 5
   About Uniview Theater ............................................................................................................... 5

Acknowledgements .......................................................................................................................... 7

Starting Uniview Theater .................................................................................................................. 8
   The Launcher .............................................................................................................................. 8
   Edit Profiles .............................................................................................................................. 9
   Uniview Folders ......................................................................................................................... 11
   Synchronization ......................................................................................................................... 12

User Interface - Overview .................................................................................................................. 12
   The User interface Window ...................................................................................................... 13

Navigation ......................................................................................................................................... 16
   Using the Mouse to Control Uniview Theater ......................................................................... 17
   The Camera Menu .................................................................................................................... 18
   The Navigation Window ........................................................................................................... 23

Simulation Time .............................................................................................................................. 27
   The Simulation Time Tool ........................................................................................................ 28

The Library ....................................................................................................................................... 30
   The Object Tree ....................................................................................................................... 30
   Object Properties ..................................................................................................................... 33
   The Surface Locations ............................................................................................................. 38
   The Bookmarks ....................................................................................................................... 39
The Custom Events ................................................................. 40
Custom Events Tool .......................................................... 40
Dynamic Objects .................................................................. 41

Geoscope ............................................................................. 45
The Geoscope Tool ............................................................ 45

The Playlist .......................................................................... 52
The Playlist Tool .............................................................. 52

Sequence Recording ............................................................. 56
Start Recording ..................................................................... 56
Stop Recording ....................................................................... 56

Advanced Commands .......................................................... 57
The Command Console Tool ................................................ 57

Render Frame Sequence ....................................................... 57
Input .................................................................................... 58
Render Settings ..................................................................... 58
Output .................................................................................. 60
Rendering .............................................................................. 60

HUD Display .......................................................................... 62
Overview ............................................................................... 62
How to Configure .............................................................. 63
INTRODUCTION

About Uniview Theater
Uniview Theater is a computer graphics platform bringing information databases to life in a 3D environment much like an immersive computer game. Loaded with scientific content, Uniview Theater brings your audience to the science and makes your stories truly meaningful and engaging. While completely interactive, your new system is powered with technologies that make sure every presentation is smooth, intuitive and engaging to the audience.

As the fastest-growing platform in the industry in recent years, Uniview Theater has been developed in collaboration with industry innovators from museums, science centers and academia. Experiencing the size of the universe in the same context as familiar sites is an enthralling and immersive experience.

The standardized user interface – based on normal Windows® components – makes Uniview Theater an easy to use and accessible tool for both experts and beginners, minimizing your initial and ongoing training costs. The smooth, cinematic motion, paired with the immersive nature of Uniview Theater, brings quality to your interactive presentations and ensures a highly satisfying visitor experience. The advanced computer graphics engine makes your new system as visually spectacular as any modern computer game, capturing the attention and meeting the demands of your visitors.

The highly evolved interactivity in Uniview Theater lets you do live presentations and virtually travel anywhere, at any time, in the universe; giving you control of your own show and allowing you to interact with your audience. Uniview Theater can record live interactive sessions and save to sequences for later playback, providing a simple yet powerful production tool that can reduce costs by orders of magnitude and allow you to update your linear programming more frequently. Uniview Theater can produce pre-rendered output in most standard formats, allowing you to produce linear shows and mix live footage with music, narration and post production effects for high end shows that makes your facility stand out.

Uniview Theater visualizes science of vastly different scales – from Earth Science and regional GIS data to large scale structures and cosmology, increasing the
usability of your display venue and multiplying your target groups. Uniview Theater scales to vastly different platforms; from Windows® PC laptops to cluster installations, allowing you to use the same tool for all your visualization needs and reuse your knowledge throughout operations. Uniview Theater allows remote collaboration and shared experiences between display venues, schools and field experts, giving you the tool to integrate with your local or global community.
ACKNOWLEDGEMENTS

American Museum of Natural History develops and maintains the Digital Universe database.

Open Geospatial Consortium develops and maintains the OGC WMS specification.

Google develops and maintains the KML specification.

Smithsonian Astrophysical Observatory develops and maintains the minor planet catalogue and the MPC format.

NASA NAIF develops and maintains the SPICE toolset and many kernels.

North American Aerospace Defence Command (NORAD) developed the Two-Line Element format.

Stuart Levy and NCSA develop and maintain Partiview and the SPECK format.

Denver Museum of Nature and Science and California Academy of Sciences have supported the development of Uniview Theater far beyond what can be expected from a committed user.

Carl Zeiss and Elumenati have provided tools for geometry correction and continuous input from the community.

Windows is either a registered trademark or trademark of Microsoft Corporation.

Google and Google Earth are either registered trademarks or trademarks of Google.

ASIO driver technology is developed and maintained by Steinberg Media Technologies.
STARTING UNIVIEW THEATER

This chapter describes how to start Uniview Theater on your system. Uniview Theater provides mechanisms for starting using various profiles and customized modes.

The Launcher

To start Uniview Theater, double-click its icon in the Uniview folder of the controller computer, or use the start menu or desktop shortcut. This brings up the Launcher from which you can start Uniview Theater in default configuration or with a customized profile.
To start Uniview Theater in default configuration, press the Start (Default) button. When properly installed, this will launch Uniview Theater on all nodes across your system.

**Note:** When Uniview is running, the Start button will instead say Stop. Clicking it will shut down the currently running session.

Additional options can be displayed by clicking on Show More Options... These are:

- Edit Profiles...
- Open User Folder...
- Synchronize

---

**Edit Profiles**

Uniview profiles is a system through which users can customize their data and property settings so that multiple users on the same system can use different data and have different settings.

**How to Build a Profile**

To build a profile, click on Show More Options... in the launcher. Then click the button called Edit Profiles... to open the Profile Editor interface.
Under **Default Modules** you see a list of all the available data modules in your installation of Uniview Theater. This list corresponds to all the folders available inside the `<Application Folder>/Modules` folder.

Under **Custom Modules**, you see a list of all the modules that you have added to the installation. These can be modules that you have downloaded from the UCare site, or modules that you have created yourself. This list corresponds to all the folders available in the `<User Folder>/Custom Modules` folder.

In the upper right corner of the editor, there is a pull-down menu from which you can select what profile to edit, or to `Create new Profile...` The latter will open the `Create Profile` dialog, where you are asked to give a name to your profile. When you have given it a name and clicked Ok, the new profile is created.

To modify what data modules are loaded in a profile, use the check-boxes in the two lists **Default Modules** and **Custom Modules**. A checked box means that this data module is included in the profile and will be loaded when Uniview Theater is launched using that profile. When selecting a data module, a brief description is shown in the **Description** frame on the right hand side of the **Profile Editor** window. Descriptions are created by the respective authors of the modules.

You must also select a **Starting Location** for your profile. This is the name of the data module you want Uniview Theater to focus on upon launch. Make sure to
specify a starting location that corresponds to a selected data module, otherwise Uniview Theater won’t start.

**How to Start With a Profile**
Instead of clicking the *Start (Default)* button, click on the small arrow on the right hand side of the button. This will bring up a list of all existing profiles. Click on the desired profile to launch.

**Uniview Folders**
The Uniview installation is spread out across a number of folders as follows:

**Application Folder**
This is where all the application files reside. This folder is read-only and you should never attempt to modify or change anything in this folder or any of its sub folders since it may break your installation.

**System Settings Folder**
This folder contains all the configuration files needed for Uniview to work properly in your facility. This includes cluster settings, geometry correction, specific display adjustments etc. Do not change any of the files in this folder, or any of its sub folders, unless you’re performing system maintenance or installation work. Incorrect changes to these files may break your installation.

**User Folder**
The user folder is where all your custom files are located. This includes the following:

- Modules
- Events
- Geoscope Tilesets
- Surface Locations
- KML Objects
- Profiles
- Playlist Items
- Other Settings

These files are not critical to the integrity of your installation and deleting this User Folder will actually reset your installation to the state it was in when you first installed Uniview.

**Cache Folder**
The cache folder contains temporary files that serve to speed up Uniview operations. This includes cached WMS images, startup files etc. These files are not critical to the integrity of your installation.

**Quick Access to Folders**
To access these folders, click on *Show More Options...* in the launcher. Then click on the button called *Open User Folder...* to open the **User Folder**. Clicking on the small arrow on the button brings up a list where you can choose to open any of
the other three folders; **Application Folder, System Settings Folder or Cache Folder.**

**Synchronization**

In cluster mode, Uniview needs certain files to be available on each computer. The launcher provides functionality for synchronizing all the relevant files to all computers in the cluster.

When pressing the *Start* button an automatic check is done to see which files need to be synchronized and a standard synchronization is performed. The first time Uniview is launched this can take quite a long time since all necessary files are synched for the first time at this point.

To reach the synchronization options, click on *Show More Options...* in the launcher. Then, locate the button called *Synchronize*. Clicking on it performs a **Standard Synchronization**, while clicking on the small arrow on the right side of the button brings up another alternative: **Synchronize Cache**.

**Standard Synchronization**

This is performed whenever you’ve made any changes to the user folder, such as:

- You’ve added a new custom module
- You’ve changed something in a settings file
- You’ve added new KML objects
- You’ve added Geoscope Tilesets

To perform a standard synchronization without starting Uniview, click on *Show More Options...* in the launcher. Then, click on the button called *Synchronize*.

**Synchronize Cache**

This operation will synchronize everything that is in the **Cache Folder** on the GUI to the other computers in the cluster. To perform this synchronization, click on *Show More Options...* in the launcher. Then, locate the button called *Synchronize* and click on the small arrow on it. In the list that appears, click on *Synchronize Cache*...

**USER INTERFACE - OVERVIEW**

*This chapter describes the main window of Uniview Theater and the graphical user interface (GUI). Apart from navigation, all aspects of Uniview Theater are controlled from the GUI.*
The User interface Window

At the top of the Uniview Theater window, a number of pull-down menus are accessible through the menu bar. The important ones are, in addition to the Camera menu that we have already explored in the Basic Navigation chapter: File, Windows and Bookmarks.

For menu items that are used frequently, you may find hints to keyboard shortcuts that will trigger the same functionality.

The File Menu

The file menu contains five alternatives: Open Producer..., Make Screen Shot..., Render Frame Sequence..., Settings... and Exit.

Note: Producer and Render Frame Sequence are part of the optional Producer add-on and may therefore not exist on your system.
Open Producer... will open a new window with the Uniview Producer Interface. Detailed instructions on how to use Producer can be found in the Uniview Producer User Guide.

Make Screen Shot... makes it possible to take screen shots within Uniview if running in standalone mode.

Render Frame Sequence... opens up the rendering frame sequence user interface. See the chapter Render Frame Sequence for documentation on this feature. Note that this option is only available on standalone installations.

Choosing the Settings... option will bring up a window that where you can make certain changes to the way that Uniview Theater behaves. Changes you make are saved permanently if you press Save. Cancel will discard any changes.

The Settings Dialog consists of two sections; Labels and Input. For labels, you can choose to check or uncheck the World Space Labels check box. If checked, the size of object labels will depend on their distance to the viewer. You can also choose to check or uncheck the Rotate 180 Degrees check box. This option allows you to flip the labels 180 degrees. This is useful in certain dome configurations.

Clamping of label size means that when world space labels are enabled, the clamping values will determine the minimum and maximum sizes of the labels. The size slider allows you to change the size of all labels in Uniview Theater at the same time. And finally, the singularity direction is best explained as the direction which is to be considered pointing “up” on the display. On a single-screen computer display, the singularity should be set to Heading: 0, Pitch: 270, Roll: 0. In a dome, the singularity can be set to a suitable value, depending on the dome environment.

In the Mouse section, use the two check boxes to flip the input of the mouse in case you feel that the default input scheme is unnatural to you. The sensitivity of the mouse can be adjusted with the Sensitivity slider. Higher values mean that less mouse movement is required when navigating.
The Windows Menu

The Windows menu allows you to customize the user interface. By triggering the Full Screen menu item (or by pressing F11 on the keyboard), Uniview Theater is set to full screen mode. Doing so will remove the borders of the main Uniview Theater window as well as the menu at the top of the screen. Pressing F11 again will bring you back to default windowed mode.

The Windows menu also lists all the tool windows in Uniview Theater. These help you control various aspects of the system. The tool windows are small, floating windows which can be moved to any location on the screen. You can enable or disable individual tool windows from the Windows menu. The most important tool windows can also be directly accessed through the Main Toolbar where they are represented as small icons.

By selecting the Hide Tools option (or pressing F9 on the keyboard) you will hide all tool windows. Pressing F9 again will bring the tool windows back. By selecting the Reset Tools to Default Layout option (or pressing Alt-R on the keyboard) you restore all tools in the graphical user interface to their default position and visibility states. Finally, by using the Save Current Tool Layout you can save your current layout so the graphical user interface looks the same the next time you start Uniview Theater.

The Status Bar
The Status Bar is located along the bottom of the main window. The slider control to the right lets you change the field-of-view of the rendering viewport. In a
cluster environment, this action will only affect the control machine. The status bar also shows your current travel velocity and distance to target and what kind of camera friction is enabled.

**The Main Tool Menu**

![Main Tool Menu](image)

The Main Toolbar lets you show/hide the most common tool windows in Uniview Theater. The buttons represent (from left to right):

- Library
- Geoscope
- Navigation
- Time
- Playlist
- Custom Events
- Command Console

**NAVIGATION**

This chapter describes the concepts of navigation in Uniview Theater. It gives an overview of the camera model and explains how to use the mouse to navigate through the virtual environment. Throughout this chapter, we will use the term Camera to refer to the viewpoint in space at any given time. Moving through the three-dimensional environment is consequently referred to as camera movement.
Using the Mouse to Control Uniview Theater

All navigation in Uniview Theater is done with the mouse. The input is based on relative movements of the mouse and only while certain buttons are pushed. This allows you to easily achieve smooth movements and eliminates the risk of the camera “flying away” should the mouse be moved by accident. The normal procedure is to press and hold a button of choice. As long as the mouse pointer is moved while a button is pressed, the camera accelerates. As soon as the button in question is released, the camera slows down and comes to a halt. This concept is called Friction and will be explained a little bit further down in this section.

The actual position on the screen at which you press a button the first time has no real impact on the resulting camera movement. Only the movement of the mouse after the button has been pressed affects the camera. The most common camera modes in Uniview Theater are called Orbit Mode, Surface Mode and Sky Mode, all accessible from the Navigation Window. There is also one other camera mode; Free Flight.
The Camera Menu

The Camera Menu is a way to access camera specific options. You can change between the camera modes orbit and free flight, as well as toggle rotational and translational friction. These commands are explained in detail in the Basic Navigation section below. You can also use this menu to trigger the most common camera lock modes; Lock to Current Target, Lock to Sun and Release Lock and also Start Recording of a flight sequence, described in a later chapter.

**Orbit**

This is the default and most commonly used camera mode in Uniview Theater. In this mode, the camera’s focus is locked directly at the center of the object of interest, the target, and moves in spherical orbits around it.

**ROTATING**

If you press and hold the left mouse button and drag the cursor in any direction, the camera will start rotating in an orbit around the target. The further you drag the cursor from the movement’s point of origin, the faster you will rotate. As soon as you release the left mouse button or drag the cursor back to the movement’s
point of origin, the rotation will slow down and eventually come to a complete halt.

Even though there strictly speaking is no up or down in space, it is sometimes convenient to align the view if it seems to be upside down or slightly unaligned. By pressing and holding the middle mouse button and dragging the cursor to the left and right, it is possible to roll the view around the viewing direction.

**MOVING**
To change the distance to the target, press and hold the right mouse button and then drag the cursor up in order to move closer, or down to move further away. Uniview Theater automatically adjusts the velocity of the camera depending on the distance to its target. When you release the right mouse button, the camera will slow down and eventually come to a complete halt.

**ADJUSTING ANGLE**
If you press down CTRL at the same time as you are rotating the camera will instead rotate around its on center. When releasing the CTRL button, the camera will return to normal navigation – but no longer be facing straight at the object. If you approach a planet, rotate 90 degrees around its own axis and then continue to orbit, the appearance will be similar to that of an aircraft flying over the surface of the planet.

**LOCKING**
While in Orbit Mode, it is possible to “lock” the camera to a secondary object. Locking to an object means that the locked object stays at a fixed location on the screen/dome. The difference between orbit with or without locking enabled may not be noticeable if the target and the locked object barely move in relation to each other. Once you increase speed of time in Uniview Theater, the difference will however soon become obvious.

**Free Flight**

Even though convenient in most scenarios, it may not always be desirable for the camera’s focus to be locked on a certain object. In orbit mode, it is for instance not straight-forward to fly away from a certain position without looking back at it at the same time. For complete freedom of movement, the Free Flight Mode is
the better choice. When this mode is activated, any previously held lock on any object (such as a planet in orbit mode), is released. From now on you may rotate any way you want and you may move to any position you want.

**ROTATING**
To rotate the camera, press and hold the left mouse button while dragging the mouse in any direction. Rolling is done just like in orbit mode by pressing the middle mouse button and dragging the cursor to the left or right. As usual, if a button is released, rotation will come to a halt.

**MOVING**
Right-clicking and dragging the cursor up or down will move the camera forwards or backwards. Release the right mouse button to stop.

**Friction**
Uniview Theater applies certain types of friction to its camera regardless of camera mode. The friction causes the camera to slow down gradually instead of immediately stopping its movement. It also prevents the camera from accidentally achieving too high velocities. You may change whether or not friction should be applied. An operator can set the camera into a slow rotation in orbit mode with rotational friction disabled. After this, the camera will keep rotating around the target, giving the viewers a good way to capture the three dimensional structure of what they are seeing. While in this mode, the operator can release the controls and focus on other things than controlling the camera.

**Transitions**
When you switch between camera modes or change target in orbit mode, the camera may need to move from one position to another. These movements are referred to as transitions. In many cases it is possible to get an automated transition where the camera enters an autopilot mode during which it moves from point A to point B. These offer a continuous ride through space. Once the destination is reached, the user will regain control over the camera. Should the user not wish to wait for the camera to fly to the destination on its own, it is also possibly to do a direct jump to the same point. During this jump the camera will fade to black and then fade back again.

**Keyboard Controlled Camera**
The keyboard can be used to complement the mouse driven camera control as follows:

**Arrow Keys:** Press an arrow key to start a continuous rotation in that direction. Each consecutive press will increase the speed of the rotation. This is very similar to frictionless rotation, but with the difference that as soon as you perform any mouse controlled rotation (left click) the current rotation will stop. This is a safe and easy way to perform a continuous motion of the camera while still avoiding the complications of using frictionless mode.
**PageUp/PageDown:** In a similar fashion, press PageUp/PageDown to start a continuous backwards/forward translation. Each consecutive press increases the velocity. As soon as you perform any mouse controlled translation (right click) the keyboard triggered translation will stop.

**END Key:** Press the END key to stop any current rotation triggered by the keyboard.

**Lock to Current Target**
Locking to the current target will result in the camera following any rotation of the target object. So, if you for example target the Earth and select this option the camera will stay in a fixed position relative to Earth while the surrounding environment rotates. This mode is useful if you want to explore the surface of a planet or moon.

**Lock to Sun**
Locking to the Sun has the effect of the Sun staying in a fixed position on the screen. This mode can be helpful when explaining phenomena such as seasons or eclipses.

**Release Lock**
Another way of describing Release Lock would be Lock to Stars. Select this option to have the stars in fixed position on the screen whenever you stop moving.
The Navigation Window

The Navigation window is enabled through Windows->Navigation menu or by clicking its button in the Main Toolbar.

The Navigation Window is the information window for the navigation in and between Orbit, Surface and Sky Mode. By clicking one of the icons for Orbit, Surface or Sky you will transition to that specific mode and also closer or further away from the target. To launch the navigation window, click the navigation icon in the main Uniview Theater toolbar. All blue marked parameter values are adjustable by clicking on them, like a hyperlink in your browser.

Switching between modes will trigger automatic transitions if appropriate. This can be avoided by holding down SHIFT while clicking on the icon, holding down SHIFT will try to do an instant switch without any transition. So the camera will be converted in-place and start controlling using the specific camera mode.
Orbit mode will have the camera looking at the center of a planet or object and rotating around this point. For a more detailed explanation of the camera mode, please read the section named *Orbit* in the *Camera Menu* section.

**INPUT**

<table>
<thead>
<tr>
<th>Input</th>
<th>Modifier</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left mouse button</td>
<td></td>
<td>Hold and drag left/right or up/down to rotate around target.</td>
</tr>
<tr>
<td>CTRL</td>
<td></td>
<td>Hold and drag left/right or up/down to rotate camera around camera position.</td>
</tr>
<tr>
<td>Right mouse button</td>
<td></td>
<td>Hold and drag up/down to move camera in or out from the target.</td>
</tr>
<tr>
<td>Middle mouse button</td>
<td></td>
<td>Roll camera around direction from cam position to target.</td>
</tr>
</tbody>
</table>

**MODIFIABLE FIELDS**

Target Name
Clicking on the Target name will bring you to the library search field.

Locked To
The Locked To will bring up the locking pop-up:
The symbols mean from left to right:

- Lock to target
- Lock to Sun
- Release lock

**Surface Mode**

The surface camera mode is designed to explore the surface of a planet, it controls in much the same fashion as the orbit mode but with the target attached to the surface of the planet. The difference is that the target can be moved on the surface (SHIFT + left click and drag) and that there are constraints to avoid the camera going below the surface of the planet.

**INPUT**

<table>
<thead>
<tr>
<th>Input</th>
<th>Modifier</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left mouse button</td>
<td></td>
<td>Hold and drag left/right or up/down to rotate around the surface target.</td>
</tr>
<tr>
<td>CTRL</td>
<td></td>
<td>Hold and drag left/right or up/down to rotate camera around camera position.</td>
</tr>
<tr>
<td>SHIFT</td>
<td></td>
<td>Hold and drag to move surface target along surface.</td>
</tr>
<tr>
<td>Right mouse</td>
<td></td>
<td>Hold and drag up/down to move</td>
</tr>
</tbody>
</table>
### MODIFIABLE FIELDS

**Azimuth**
Clicking on the Azimuth value will bring up the compass tool. Clicking on one of the eight buttons will aim the camera in that direction on the planet.

![Compass buttons](image)

**Target Name**
Clicking on the name of the target (Location or a named location) will bring up a location search bar. You can enter a coordinate in the WGS84 format, for example “52°N 13°E” and then clicking on the rocket to either jump to or fly to the location.

![Location search bar](image)
Sky Mode

Sky mode is designed for observing the sky from a planet surface.

**INPUT**

<table>
<thead>
<tr>
<th>Input</th>
<th>Modifier</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left mouse button</td>
<td>Hold and drag left/right or up/down to rotate the camera to look at different parts of the sky.</td>
<td></td>
</tr>
<tr>
<td>SHIFT</td>
<td>Hold and drag to move the surface location around the surface of the planet.</td>
<td></td>
</tr>
</tbody>
</table>

**SIMULATION TIME**

This chapter will describe how to control time. Uniview Theater is a running simulation, where planets, moons and other objects travel through space as time passes. In this chapter, you will learn how to adjust the simulated time in Uniview. The Time Control tool is enabled through the Windows- >Simulation Time menu, or by clicking its button in the Main Toolbar.
The Simulation Time Tool
Use this tool window to set the simulated or "virtual" time in the Uniview Theater environment. All the planets, moons and satellites are affected by this time.

Basic Controls

Simulation speed in Uniview Theater is expressed in how fast the simulation runs compared to real-world time. Two simulation seconds per real-time second means that the simulation runs twice as fast as the real world. Click on the up/down arrows next to the left text field to adjust the simulation speed. You may also type a number directly into the text field and press ENTER. The pull-down menu on the right contains units, such as seconds, minutes and days. So, for example, typing the value “2” into the text field and selecting the unit “Minutes” means that the simulation will run at a rate of two minutes per second.

If you want to temporarily speed up the simulation time, use the shuttle speed slider. The further to the right you drag the slider, the faster time will pass. If you drag the slider left, time will go backwards. When you release the slider, the simulation time will slow down to the preset rate again. Adjust the speed by dragging the slider and press the “t” key on the keyboard and the simulation speed will continue to run at the rate specified by the slider.
The icons in the bottom of the window do the following, from left to right:

- Toggle between Annual and Diurnal motion
- Toggle between reversed and forward simulation time
- Set simulation speed to one simulation second per real-time second.
- Go back one time step
- Pause and start simulation time
- Go forward one time step.

The *Date & Time (UTC)* field shows the current simulation time. You can change time by clicking the current simulation time. Then a new window appears, where you can specify a specific date and time. In the bottom of the window there are also a few icons, from left to right, that can set the simulation time to current time or set time to dusk, noon, dawn or midnight, relatively to the current time. Press Set to let the changes take effect.
THE LIBRARY

It is possible to load a large amount of data into Uniview Theater. This chapter introduces the Library – a multipurpose tool which lets you browse all objects, change their visibility, and trigger automatic camera transitions. The Library is enabled through the Windows->Library menu, or by clicking its button in the Main Toolbar.

There are four different tabs in the library: one each for the object tree, surface locations, bookmarks and custom events. A marked object can be dragged to the Playlist and for custom events to the Custom Event Panel as well.

The Object Tree

The Object Tree gives you access to all objects and lets you perform various operations, such as toggling their visibility and triggering camera transitions. The Object Tree is sorted into groups in order to help you find objects quickly. Each of these groups contains additional sub groups or categories. Clicking on the plus symbol (+) next to a group will expand the group and show its contents.
**Toggle the Visibility of Objects**
Each item in the object tree has a checkbox next to it. This checkbox represent the visibility of the object. When you first start Uniview Theater, you will notice that some boxes are checked and others are not. This is the default configuration but you may change this to better suit your needs. Clearing a checkbox will hide the object in question while marking a checkbox will reveal the object. You may also show or hide an entire group of objects by pressing the SHIFT key when clicking on a group checkbox. Let’s say you want to hide all solar system objects. Simply press SHIFT and clear the Solar System checkbox and all planets and moons will disappear.

**The Context Menu**
Right-clicking on any item in the object tree will bring up the Context Menu. Apart from toggling visibility with the checkboxes, all of the object tree functionality is accessed from this menu. The options available in the context menu are:

- Target
- Fly To
- Jump To
- Lock
- Lock And Align

**TARGET** will rotate the camera towards the object. Once the rotation has finished, the camera will be in orbit mode around the new object.

**FLY TO** will launch an automated flight to the object that you have right-clicked. When the destination has been reached, the camera will be in orbit mode around the new object.

**JUMP TO** is similar to FLY TO except that it triggers a “jump” to the object. When the “jump” has finished, the camera will be in orbit mode around the new object.

**LOCK** effectively changes the frame of reference for the camera. Locking to an object will make that object stay in a fixed location on the dome/screen as long as no manual camera movement is performed. This option does not change the current target object.

**LOCK AND ALIGN** does the same as the Lock command described above, but also triggers a transition whereby the camera rotates to look at the locked object.

**Searching for Objects**
Start typing in the field *Search all objects* and the tree will display all objects corresponding to the search text. Use the arrow keys to move between search results, and press ENTER to bring up the context menu. Press ESC to go back to showing all objects again.
Object Properties
This section explains how to change the appearance and behavior of the various objects in Uniview Theater.

If you do not have the Properties Tool visible underneath the Object Tree window you can access it by clicking the lower right side icon visualizing a pen. The layout of the Properties Tool depends on which object you have selected in the Object Tree. Uniview Theater supports several different object types and each of those has their own layout.

Point Objects Properties
Point Objects refer to all data sets made up by collections of points. Stars, galaxies and many astronomical surveys are expressed as point objects. This data format was originally developed for the Partiview software and as such it has a few additional capabilities including representation of very simplistic geometries.

GENERAL SETTINGS
The visibility setting controls the visibility of the object (or data set). The visibility can be set to On, Off or Auto. While the On and Off states are easy to understand, Auto requires further explanation:

Displaying too much data at the same time may be confusing to the audience. The Auto state helps you manage the visibility of data sets by automatically showing and/or hiding them depending on the context.

For example, when flying through the solar system, the galaxies and other remote objects are hidden, as they would otherwise clutter the night sky. As you leave the Milky Way, those objects will automatically start to appear. Even if this is helpful in many situations, you may want to override this behavior. Do this by changing the visibility setting from Auto to On or Off.
The label setting lets you set the visibility of labels for the object (or data set).

The Color Picker lets you change the color of the object or data set. Please note, however, that certain point objects use their own custom color map. Changing the color for such objects won’t have any effect.

Most point objects are rendered using both points and polygons. Use the Render Points and Render Polys checkboxes to change the rendering method.

**THE PROPERTY SLIDER**

The Property Slider lets you change many additional properties of the point objects. Select a property in the pull-down menu and drag the slider to change its value. Alternatively, you may type a new value directly into the box next to the pull-down menu.

Available properties are:

- Slum
- Alpha
- Polysize
- Ptsize [min]
- Ptsize [max]
- Polysides
- Psiz
- Lsize
- Polymin
- Polymax
- Meshsize
- Labeltargetradius

**SLUM** is a brightness multiplier to the object.

**ALPHA** is the transparency of the object, where 0 represents fully transparent and 1 represents fully opaque.

**POLYSIZE** is a value controlling the size of polygons. Most objects are represented using both a point and a polygon and this variable can be used to control the balance of the two elements in the visual representation.

**PTSIZE [MIN]** is the threshold under which points will not become any smaller. This value can be used to control the point appearance of very distant objects.

**PTSIZE [MAX]** is the threshold over which points will not become any larger. This value can be used to control the point appearance of very nearby objects. Note that in addition to this variable the graphics hardware will impose an upper limit to the point size.

**POLYSIDES** represents the number of sides of polygon representations. Most commonly used to differ between different datasets without texture maps.
**PSIZE** is a value controlling the size of points. Most objects are represented using both a point and a polygon and this variable can be used to control the balance of the two elements in the visual representation.

**LSIZE** is a value controlling the size of the label for an object.

**POLYMIN** is the threshold under which polygons will not become any smaller. This value can be used to control the polygon appearance of very distant objects.

**POLYMAX** is the threshold over which polygons will not become any larger. This value can be used to control the polygon appearance of very nearby objects.

**MESHSIZE** is a value controlling the line width of wireframe meshes.

**LABELTARGETRADIUS** is a value controlling the distance from a point in a dataset where the camera will stop upon automatic transitions (i.e. fly-to).

---

**Geometrical Objects Properties**

The *Properties Tool* for geometrical objects (planets, moons and satellites that have a more detailed representation than a point or a flat polygon) contains three different sections which you can switch between by clicking on the tabs at the top of the window. The sections are *Appearance*, *Trajectory*, and *Marker*.

---

**THE APPEARANCE TAB**

The *Appearance Tab* lets you change the visual appearance of the orbiting object. Use the *Visibility* settings to control the visibility of the object and the label setting to set the visibility of the label for an object.

If you want to rescale an object, type in the desired scale in the *Scale* dialog, the desired duration of the animation changing the scale in the *Duration* dialog and
press Set. The object will smoothly rescale itself to the new scale in the amount of
time specified as duration.

THE TRAJECTORY TAB
The Trajectory Tab lets you change the visual appearance of trajectory
representations, which means the trace of movement behind any moving
geometrical object (such as planets and moons in orbit). Use the Visibility settings
to control the visibility of the trajectory representation. You can choose the
appearance of the trajectory by using the Type menu. Available modes are Line,
Points, Simple Line and Simple Points.

Use the Color Picker to change the color of the trajectory and set the opacity value
to affects how transparent the trajectory should be. 100% opacity equals no
transparency – 0% opacity equals full transparency (i.e. the trajectory won’t be
visible). Change the width value to make the trajectory line thicker or thinner.

RELATIVE OR ABSOLUTE ORBITS
Relative rendering means that the length of the trajectory will be relative to one
full period. If you select Absolute, you will be able to explicitly define the length of
the trajectory in terms of duration of time. The Fade value specifies how soon the
trajectory should begin to fade out. Set this value to 0% if you want a completely
solid orbit. This value specifies the actual length of the trajectory. In Relative
mode, it is specified as a percentage of a full period. In Absolute mode, this field
lets you specify the duration of the trajectory.

THE MARKER TAB
The Marker Tab lets you add various grids and markers to an object. These can be
helpful teaching aids when explaining astronomy and the solar system. Nota bene,
there are markers specifically designed for Sky Mode. These can be found in the
Surface Location tab.

Create a new marker by pressing the New button. This will bring up a context
menu where you can choose which of the 15 available marker types you want to
create. The available types are:

- Altitude / Azimuth Grid
- Cardinal Points
- Cartesian Grid
- Coordinate System
- Equator
- Latitudal Line
- Local Meridian
- Location Marker
- Longitudal Line
- Long/Lat Grid
- Meridian
- Pole Lines
- Radial Grid
Select a type and the tab will change its appearance and let you set the color of
the marker using the color picker, specify the opacity value of the marker, line
width and label rendering. You can also choose to project certain markers to
infinity instead of being placed on the object. This is very useful for comparing
markers on two different objects. Mark this checkbox to enable projection.

**MISC SETTINGS**
The misc settings vary for different markers. Some have a spacing value, which
specifies the resolution of grids. This value is a multiplier of the object radius.
When available, use any combination of the axis check boxes to enable grids along
these planes. Other settings should be self explanatory.

**ADDING OR REMOVING MARKERS**
When you have created a marker, click the *Ok* button to add it to the geometrical
object. This takes you back to the original look of the *Markers Tab*. Now you can
select any marker and click *Edit* to change its settings, click clear to remove all
markers or *New* to create more markers. You can also save your markers to disk
by clicking the *Save* button, so they will be available the next time you launch
Uniview Theater using the same profile.

**Massive Object Properties**
In Uniview Theater, a *Massive Object* refers to an object type which consists of a
large number of small objects in orbit. An example of a *Massive Object* is the GPS
satellites hovering above Earth. All these satellites are treated as one single
object, which means that by editing the properties for a *Massive Object*, you
simultaneously change the attributes for all objects within that specific data set.

The *Visibility* setting lets you choose whether the objects should be visible or not.
Use the *Labels* checkbox to display label names (when available) for the individual
objects.
Use the color picker to set the color of the object representations. Each set of massive objects can have two colors, one for their orbit lines and one for the point representing the actual body at any given point in time. The alpha value lets you adjust the transparency of the object representations.

Many data sets consist of so many objects that it may degrade performance if all are rendered at once. Adjusting this value will increase or reduce the number of objects being rendered. A value of 1.0 will render all objects and a value of 0.0 will render nothing.

The pull-down menu at the bottom of the window lets you select the render method for the trajectories. Available options are None, Orbit and Trail. Trails are left behind moving massive object bodies so that their position over the last few hundred frames is tracked. The faster a body moves, the longer its trail.

**The Surface Locations**

The Surface Location tab is found in the Library. A surface location is a specific location on Earth, or certain other planets, that you can save and later jump or fly back to. Uniview comes with a bunch of default surface locations, but it is easy to create your custom locations as well.

Create a new surface location by clicking the ‘+’ in the Surface Location tab. This will open the *Surface Locations properties* dialog where all relevant data such as name and position can be set. A day and night panorama can also be added to the location. Going to a surface location in sky mode also enables a set of relevant grids and markers found in the Surface Location tab.

**Surface Location Files**

The surface locations are save in the `<User Folder>/Surface Locations/` folder.
The Bookmarks

The Bookmark tab is found in the Library. A bookmark is a specific location in space, and optionally time, that you can save and later jump or fly back to.

Create new bookmarks by clicking the ‘+’ in the Bookmark Library tab. This will open the Add Bookmark dialog and ask you to give the bookmark a name. The Add Bookmark dialog also has a checkbox which says “Save current simulation time in bookmark”. This checkbox lets you control whether the simulation time should be saved with the bookmark or not.

All bookmarks that you create are available for later use to you through the Bookmark Library, and you can choose to fly or jump to a bookmark. Now, if you choose to fly to a bookmark that includes simulation time, you will trigger not only a camera transition, but also a time transition. You will see planets move along their orbits, rotate along their axis and so forth when flying to a bookmark with a distant timestamp. It is worth noting that while time transitions can be very effective and spectacular, they can behave less smooth when covering a large span of time.

Choosing NOT to include simulation time in the bookmark may produce a slightly different visual presentation when returning to the bookmark, depending on if there are time-dependant (moving) objects present at the bookmark location. This is because when you go to this type of bookmark, whatever simulation time you currently are using will be kept when arriving at the bookmark location, thus it may not be the same simulation time as when you created the bookmark. The advantage of taking this approach, however, is that you will be able to fly to the bookmark without visual artifacts, because no time transition will occur.

**Bookmark Files**

If you have created a set of bookmarks that you want to share with other Uniview Theater users, you can find the files corresponding to your bookmarks in the `<User Folder>/profiles/<profile-name>/bookmarks` folder.
The Custom Events
The Custom Event Library tab is found in the Library, marked with a star. A custom event is a simple script to trigger actions to tend to use frequently.

To add a new Custom Event, click the ‘+’. A new window will open where you can edit the behavior of the button.

- The Name field lets you specify the text that should appear on the button.
- In the Commands field, type in one or several commands that should be triggered by the button. If you’re entering several commands, make sure that they are separated by either a semi-colon or a line break between each of the commands. Refer to the run-time command syntax documentation for information about available commands in Uniview Theater.
- Press OK to create the new button.

To add a selected Custom Event to the Custom Events Tool, simply drag it to the tools window.

Custom Events Tool
The Custom Events Tool is enabled through the Windows->Custom Events menu, or by clicking its button in the Main Toolbar. The panel allows you to store the events you use frequently and is profile specific.
Dynamic Objects

You can drag and drop images (from file on disk or an image from a web page) onto the Univew Render Window on the GUI machine and have them displayed onto the dome. Currently three kinds of image objects are supported. “Simple Image”, “Fish Eye Image” and “Equirectangular Image”. Dropping over an already existing “Simple Image” object will replace the image of the object with the new image.

**Supported File Formats**
Currently the supported file formats are: *.jpg, *.jpeg and *.png

**GUI Interface**
SAVE
Saves the images in your current profile. If you have not saved an image then it will not be present the next time you load the profile in uniview.

Also any changes made to the dynamic image properties will not be written to disk unless they are saved again. A modified image object has "(modified)" written after its displayed name.

DELETE
This removes the image object from the Library tab. If the object was previously saved to the profile then it would also be removed from the profile.

REFRESH
If the image object was previously saved in the profile, then this will reapply the saved properties of the image object. In effect this will reload the saved state for the image object.
<table>
<thead>
<tr>
<th>Name</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>DisplayName</td>
<td>The name of the image object that will be shown in the library tab and the panels.</td>
</tr>
<tr>
<td>Enabled</td>
<td>Hides or shows the image object.</td>
</tr>
<tr>
<td>DomePosition</td>
<td>Dome space position of the image</td>
</tr>
<tr>
<td>Depth</td>
<td>Depth of the image from 1 to 1000</td>
</tr>
<tr>
<td>Rotation</td>
<td>Rotation values in degrees about object’s x,y and z axis</td>
</tr>
<tr>
<td>Scale</td>
<td>Scale of the image</td>
</tr>
<tr>
<td>AspectRatio</td>
<td>The aspect ratio of the image.</td>
</tr>
</tbody>
</table>

**Simple Image Properties**

<table>
<thead>
<tr>
<th>Name</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>DisplayName</td>
<td>The name of the image object that will be shown in the library tab and the panels.</td>
</tr>
<tr>
<td>Enabled</td>
<td>Hides or shows the image object.</td>
</tr>
<tr>
<td>Alpha Multiplier</td>
<td>Multiples with the alpha of the image. Valid values from 0 to 1</td>
</tr>
<tr>
<td>Depth</td>
<td>Depth of the image from 1 to 1000</td>
</tr>
<tr>
<td>Rotation</td>
<td>Rotation values in degrees about object’s x,y and z axis</td>
</tr>
<tr>
<td>ColorMultiplier</td>
<td>Component wise color multiplier</td>
</tr>
<tr>
<td>AspectRatio</td>
<td>The aspect ratio of the image.</td>
</tr>
</tbody>
</table>

**Fish Eye Image and Equirectangular Image Properties**

**Render Window Interface**

For this discussion, the Uniview Render Mode for Gui machine should be in "DomeView". Quick way to do that is to move the fov slider on the bottom-right all the way to the right.

**SELECTING AN IMAGE OBJECT**

Left click once on the image object to have it selected. The image will have a visible selection border around it. Also the selected image object will get selected in the library tab as well. After which you can apply the input as described in the next section.

To unselect an image object just left-click outside the image object anywhere inside the Render Window.
<table>
<thead>
<tr>
<th>INPUT</th>
<th>Modifier</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left mouse button</td>
<td></td>
<td>Move the selected image in dome space.</td>
</tr>
<tr>
<td>Right mouse button</td>
<td></td>
<td>Scale up or down the image. Notice that the mouse motion should be in a vertical direction.</td>
</tr>
<tr>
<td>CTRL</td>
<td></td>
<td>Changes the image depth instead. Again the mouse motion should be in a vertical direction</td>
</tr>
<tr>
<td>Middle mouse button</td>
<td></td>
<td>Rotate the object around its local z-direction. Notice that the mouse motion should be in a horizontal direction.</td>
</tr>
</tbody>
</table>
GEOSCOPE

This chapter describes the new Geoscope toolset, turning Uniview Theater into an online 3D browser for satellite imagery.

The Geoscope Tool

Geoscope is a feature in Uniview Theater that allows you to bring in data from online sources including WMS servers and KML files.

Introduction to WMS servers

WMS servers are repositories of imagery that can be downloaded directly into Uniview Theater. WMS is a common standard developed by the Open Geospatial Consortium. Existing WMS servers publish data available for Geoscope in a format that we will refer to as a layer. Think of a layer as a map, either a global or a local map with an often very high resolution.

Adding Layers

To launch the user interface for the Geoscope feature set, click the globe icon in the main menu of Uniview Theater. This will bring up the Geoscope Tool. This tool operates on and affects the appearance of spherical bodies, such as planets, in Uniview Theater. The default body to affect is the Earth, but you can apply Geoscope features to certain other planets and moons as well. When targeting a body with support for Geoscope features, you will see that the title of the Geoscope Tool will change to the name of that body.
To add a layer to the Earth or to another planet you have selected, click the plus icon or select Add Layer… from the Layer menu. Both these operations bring up the Add/Edit menu.

First, let’s take a look in the Server Browser pull-down menu. Expand the menu to see what servers Geoscope is currently aware of. Selecting one of them will give you a list of all available layers from that server. Layers are typically organized in a hierarchy on the server, but how this hierarchy is arranged is entirely up to the server provider. You can browse the hierarchy of the server you have chosen by clicking the plus and minus signs in the server hierarchy frame until you reach any single layer. It is these bottom-level layers that contain the actual data.

When you click a layer from the hierarchy, if available a short description of the layer is shown in the Layer Description frame in the bottom of the window. This text is also provided by the server and some servers provide very detailed and useful information while other servers don’t provide any information at all. To add a selected layer, click the Add button in the lower right corner of the window.

Once you have clicked add, the Add/Edit menu disappears and you are back to the main Geoscope Tool again. Only this time, the white frame making up the major part of the menu is not empty but contains the name of the layer you have just added.

**Modifying Layers**

Through the main interface menu, you can perform simple operations on layers. Using the check boxes next to them to show or hide individual layers. You can also select a layer and use the Opacity slider to make the layer more or less transparent. Notice that using this slider will affect the entire layer. In many cases there are both opaque and transparent portions of a layer. To display that properly, don’t use this slider but rather the Use Transparency check box as described below. It is also possible to remove a layer from Geoscope by selecting it and clicking the minus icon or selecting Remove Selected Layer… from the Layer menu. Another sometimes useful feature when working with layers that are not
global is the *Crosshair* button that automatically refocuses the camera to hover above the area of the selected layer.

More advanced properties of a layer are accessible from the *Add/Edit* menu. You can either modify advanced properties directly when you add a layer, or later by double-clicking the layer in the main user interface or select *Edit Selected Layer...* from the Layer menu.

![Add/Edit Layer dialog box]

Double-clicking a layer brings up the *Add/Edit* menu again. In this menu, there is a button called *Show Layer Properties* ➤. Clicking this button expands the view to reveal the advanced properties.

The *Follow Terrain* checkbox is used to indicate whether you want Geoscope to generate new geometry for a layer or paste the layer textures onto the existing geometry for a planet. In most cases, it is not useful to generate new geometry so keep this box checked for most part.

*Use Transparency* is a useful checkbox. Most WMS servers can deliver their layers either with or without transparency information. If a layer contains data that highlights or emphasizes certain locations only, it is likely that there are fully transparent portions of the layer. As an example, think of a layer showing global political boundaries. Whereas the boundaries themselves are global, the actual landmasses are transparent. Unfortunately there is no standardized way to ask a WMS server if a layer contains transparent parts or not, so Geoscope asks you to use this check box to indicate the presence of transparency information in a layer.
Specify Date lets you request not only a layer, but the content of that layer at a given date. Many servers don’t change their layers’ content over time, but some do and in some cases it is important to be able to request a specific date. As an example, think of a layer showing forest fires globally. It is likely that you are not interested in the forest fires as they are today, but as they were on a specific date. Use this check box and the accompanying calendar tool to indicate what date you are interested in.

Draw Order of Layers
If you have added multiple WMS layers to a body, they are drawn on top of each other according to the order in which they are listed in the Geoscope main user interface window. This means if you have two fully opaque global layers, only the top one will be visible.

You can change the drawing order by grabbing a layer in the user interface and dragging it to the top of the list. Pay attention to the drawing order, and particularly to the fact that transparent layers will reveal underlying ones.

Loading Indicator
When a WMS layer is in the process of downloading data from the server, the layer text will change from black to blue. Also the status bar of the main Uniview Theater window will display the text “Downloading WMS data…”.

Adding Servers
While Geoscope ships with connections to a number of default servers, you can dramatically improve the capabilities of Geoscope by adding new servers. To do this, click the plus icon or Add New Layer… in the Layer menu of the main user interface window again to bring up the Add/Edit window. Instead of selecting an existing server in the Server Browser select the Add New Server… option at the bottom of the pull-down menu.

This will bring up the Server Connection dialog. The WMS standard defines an interface for clients like Geoscope in Uniview Theater to try to connect to servers. This standard is called a GetCapabilities request, and is basically a web address. GetCapabilities web addresses can be typed into the address field of a web browser, and the corresponding site will show up as an XML file, i.e. a Capabilities Response. When you type in a GetCapabilities web address in the Server Connection dialog of Geoscope, the exact same thing happens except Uniview Theater and Geoscope saves you from having to view the XML file. Instead of opening the address in a browser, Geoscope opens it internally, downloads the Capabilities Response and interprets it to see if it is a valid server and if so what layers it contains.
A `GetCapabilities` request or web address has a very specific structure. First comes the address to the WMS server. After that follows parameters that are passed along to the server, so that it will know exactly what Geoscope is asking for. Let’s look at a typical `GetCapabilities` address:

http://neowms.sci.gsfc.nasa.gov/wms/wms?version=1.3.0&service=WMS&request=GetCapabilities

The first part, “http://neowms.sci.gsfc.nasa.gov/wms/wms”, is the address of the server. Then follows a question mark, which indicates that hereafter we are specifying parameters. Each parameter is separated from the previous by an ampersand (“&”).

The example above contains three parameters. First “version” specifies that we want to communicate with the server using the WMS specification version 1.3.0. Second “service” specifies that we are actually interested in WMS data and no other data, the same servers can often feed other types of data too. And finally, “request” says that we are asking the server for its capabilities and not for something else. Internally, Geoscope will later do similar requests to the server but with parameters like `GetMap` instead of `GetCapabilities`.

Most WMS server providers provide the `GetCapabilities` web address on their normal web sites. And if you have a UCare support subscription, you can find many new server `GetCapabilities` addresses on the Uniview Member Zone.

Once you have specified a `GetCapabilities` request in the Server Connection dialog, you can also chose to name the server. This is your internal name for the server and has nothing to do with what its official name is or what the provider calls it. If you want to refer to the Nasa Earth Observatory server in the example above as “Fancy stuff from NASA”, that’s fine. You can always edit this name later.
Once you have filled in the Server Connection dialog, click the Save button and Geoscope will try to connect to the server. If you have made a mistake in the GetCapabilities, or if the server is down, you will get an error message.

If you have edited the name or the GetCapabilities address of a server already in the list, you can click the Reload button instead of the Save button.

**Geoscope Tilesets**

A Geoscope Tileset is similar to a WMS layer but the entire data sets exist locally on the Uniview computers rather than being streamed from a WMS server. Uniview Theater ships with a few Geoscope Tilesets in order to provide high resolution imagery for Earth, Moon and Mars. Additional Tilesets can be added to the system by placing them in the folder `<User Folder>/Geoscope Tilesets`. SCISS offer tools for creating such tilesets and you will also be able to acquire new tilesets from the UCare website as they become available.

![Add/Edit Layer window](image)

To add a Geoscope Tileset to a planet, follow the same procedure as when adding WMS layers, and then choose Geoscope Tilesets in the Server Browser drop down menu. You will then see a list of all available Geoscope Tilesets on your system. They are grouped into two categories; Default and User, where the former lists all tilesets that ships with your installation and the latter shows any tilesets that you may have added to the folder `<User Folder>/Geoscope Tilesets`. Choose a tileset and click on Add to add it to the planet.
**WMS Layers vs. Geoscope Tilesets**

The following table shows the key differences between WMS layers and Geoscope Tilesets:

<table>
<thead>
<tr>
<th>WMS Layer</th>
<th>Geoscope Tileset</th>
</tr>
</thead>
<tbody>
<tr>
<td>No internet connection required</td>
<td>✓</td>
</tr>
<tr>
<td>No pre-caching required</td>
<td>✓</td>
</tr>
<tr>
<td>Arbitrary resolution</td>
<td>✓</td>
</tr>
<tr>
<td>Customizable layer options</td>
<td>✓</td>
</tr>
</tbody>
</table>

**KML Files**

Uniview Theater also supports the *Keyhole Markup Language (KML)* file format, developed by Google™ for their Google Earth™ application. While WMS servers are used to stream raster images, i.e. satellite photography or similar, KML is used primarily for highlighting one or more locations on the surface of a body and for vector overlays.

*Geoscope* is used to load KML files into Uniview Theater. If you have a KML file that you wish to display in Uniview Theater, you need to copy that file into the folder `<User Folder>/KML Objects` for your Uniview Theater installation. If you are running on a PC cluster, you also need to synchronize your system before the KML files will work. Once properly copied and synchronized, you can access KML files in the same way as layers, but by selecting the server called Locally Stored KML Files in the Server Browser of the Add/Edit menu.

Caveat: Note that KML is customized for Google Earth™, and Uniview Theater does not support all of its features. Always try KML files during off hours before attempting to show them to an audience. Also, some KML files may take a long time to load in Uniview Theater. During this load time, Uniview Theater will be unresponsive and may appear to have frozen.

**Layer Sets**

Groups of layers can be saved for later use. To save a group of layers you have added to Geoscope, use the Layer Set menu. The same menu is used to load groups of layers from previous sessions.
THE PLAYLIST

This chapter introduces the Playlist tool. This tool lets you view pre-recorded timelines, videos and other objects. The Playlist is enabled through the Windows- >Playlist menu, or by clicking its icon in the Main Toolbar.

The Playlist Tool

The Playlist Tool lets you load and play pre-created sequences, xtimelines, videos, bookmarks and objects. The best way to think about the Playlist Tool, is like a “script” for your presentation or show. The workflow goes like this:

1. Add all elements that you want to include in your presentation, be it videos, exported Producer xtimelines or a number of interactive elements such as bookmarks or individual objects.
2. Next, rearrange them into the order you prefer by dragging the items up and down in the list.
3. Edit the transitions between the items as well as other per-item properties.
4. Optionally, save the playlist for future use.

Adding and Removing Playlist Items

Various types of objects can be added to the Playlist and the method to do so depends on the object in question. The supported operations are:

ADDING A SEQUENCE, PRODUCER XTIMELINE, OR FULLDOME VIDEO CLIP

Click on the plus button in the upper left part of the playlist window to bring up a dialog window where you can browse for the *.sequence, *.xtimeline or *.fdv file that you wish to add. The dialog will by default show you the contents of the <User Folder>\Playlist Items folder, and it is recommended that you keep all your sequences and xtimelines stored in this folder. Select one or several files to add and click on Open to add them to the playlist.
ADDING A LIBRARY OBJECT

To add a Uniview object from the library to the playlist, simply drag and drop it to the playlist or select it and press the playlist icon with a plus sign in the right corner.

REMOVING AN ITEM IN THE PLAYLIST

Click on the minus button to remove the currently selected item from the playlist.

Rearranging Playlist Items

The items in the playlist can be re-ordered by clicking and dragging the items up or down in the list.
**Edit Transitions and Other Properties**

Click on the button in the upper right corner of the playlist window to display the properties for the selected playlist item.

The playlist window will change to look like this:

The number of properties available will vary depending on the playlist item selected. Some items, such as sequences or xtimelines have several properties, while others, such as bookmarks or objects, have only one or two properties.

**PLAY MODE**

This property controls what should happen when the playlist item in question has finished playing. The available options are:

- **Continue**
  Play the next item in the playlist automatically.

- **Pause**
  Pause playback. You will need to press the buttons *Play* or *Next* to play the next item in the playlist.

- **Loop**
  Keep playing this playlist item forever, or until you press *Play* or *Next* to move on to the next item in the playlist.

Play Mode is only available for playlist items which have duration, such as sequences, xtimelines or video clips.
TRANSITION
This setting controls which transition to use at the start of the playlist item in question. The available options are:

- **Instant**
  A direct cut from the previous item to this one.
- **Fade**
  Perform a fade-to-black transition when switching from the previous item to this one.
- **Fly**
  Perform an automated flight between the previous location and this one. This mode is only available for bookmarks and objects.

START TIME, END TIME & DURATION
These settings let you specify which part of a sequence, xtimeline or video clip that you want to play. By default, start time will be 00:00:00 and end time will be the total length of the playlist item. By changing these values, however, you can choose to play only a part of the playlist item. This can, for example, be useful if you want to avoid an undesired part of a sequence file, or if a video clip contains metadata on the first few frames that should not be displayed to the audience.

It’s worth mentioning here that you can add the same item to the playlist several times. So if you, for example, have a sequence file that you have recorded, which has a section in the middle that you want to remove, you can do this by adding the sequence twice and set the start and end times in such a way that the middle section is not played.

Loading and Saving a Playlist
The Playlist menu at the top of the playlist window has the options Load Playlist..., Save Playlist... and Clear Playlist.... Use these options to load/save/clear the current playlist. There is no limit to the number of playlists that you can create and keep on your system.

In addition to having the ability to save playlists, the current playlist will persist between sessions, so if you quit Uniview with a certain playlist active, it will appear again the next time you start Uniview. This behavior is per-profile, so you if you start Uniview with a different profile you will see the last used playlist for that profile instead.
SEQUENCE RECORDING

Uniview Theater is able to record an interactive flight for later playback.

Start Recording
To start recording your session, go to the Camera menu and select Start Recording.... Alternatively, press the F12 key.

Now you will be prompted “Do you want to start recording a camera sequence?” Click on the button Yes and the recording will start. This is indicated by a red border and a flashing “REC” message in the upper right corner.

Stop Recording
When you want to stop the recording, press F12 or go to the Camera menu and select Stop Recording... You now get the option to Preview your recorded camera sequence, Save it, or Discard it.

If you choose to save it, you will also be prompted if you want the newly created sequence to be added to the Playlist. Choose Yes if you want to.
ADVANCED COMMANDS

The Command Console is enabled through the Windows->Tools->Command Console menu, or by clicking its button in the Main Toolbar.

The Command Console Tool

The Command Console lets you control advanced features of Uniview Theater. It will allow you to send commands either to specific loaded objects or to core Uniview Theater functionality. For more information on syntax and use of commands, please refer to the run-time command syntax documentation. This tool window also offers a small history display where you can review previously sent commands. To send a command, activate the text field by clicking inside it. Type the command and then either click the Send button or simply press ENTER on the keyboard. While the text field is active, it is possible to scroll through previously sent commands by pressing the up and down arrows on the keyboard.

If you want to send a command to a specific object, make sure that it is selected in the Object Tree tool window and then press “.” in the command console text field. The uniquely identifiable object name, which you have to use to reference the object, will then be automatically inserted in the console text field.

RENDER FRAME SEQUENCE

Uniview is able to render any Producer .xtimeline, or .sequence file to a sequence of frames. To do this, select Render to Frame Sequence... in File menu. This will open the Render Frame Sequence window. Note that this window is modal, which means that the rest of Uniview Theater is inaccessible while this window is open.

Rendering a frame sequence is only possible when Uniview Theater is in standalone mode. If you are running Uniview Theater in cluster mode you need to restart Uniview in standalone mode.
Input

In the Input section, start by specifying the sequence or xtimeline you want to render.

Render Settings

The middle part of the dialog allows you to specify how the frames should be rendered. This is done by 1) specifying the global settings and 2) configuring each channel that you want to render. You can add as many channels as you want to. The number of channels correlates to how many images you want to have for each frame in a sequence or xtimeline. Normally, you want to render one channel but in cases with a multi-projector dome you may want to render as many channels as you have projectors in the dome.

Global Settings

Click on <Global Settings> in the listbox on the left to display the global settings. The following properties can be configured:

FRAMES

Specifying Frames makes it possible to render a subset of the entire sequence. To render the entire sequence, just keep the default values.
Padding specifies how many digits will be used for the frame number when deciding the filenames for the rendered frames. A value of 6, for example, would result in the files being named `frame_000012.png`, while a value of 3 would result in `frame_012.png`.

**ROTATION OFFSET**
The Rotation Offset lets you rotate the “camera rig” so that the rendered frames display a different part of the 3D environment. This is for example useful when adapting the frames to a tilted dome. For planar, single-channel, rendering, leave this with the default values 0, 0, 0.

**OUTPUT FORMAT**
Lets you specify the output format for your frames.

**OTHER**
If choosing Production Quality, Uniview will wait until all WMS data is downloaded before a frame is rendered. It is recommended to always keep this setting enabled.

**Per-Channel Settings**
By default, only one channel exists and it is called Channel01. You find in the list directly below `<Global Settings>`. Click on in to bring up its properties. If you want to add or remove channels, you can do this by clicking on the plus/minus buttons directly below the channel list. The following properties can be configured for each channel:

**RENDER MODE**
The Render Mode can be either Simple, Advanced or Omnimap. Simple and Advanced are planar images, whereas Omnimap is a fisheye distorted view following the Dome Original standard (i.e. 360x180 degrees field of view). Omnimap mode is rendered through the Omnimap SDK, courtesy of The Elumenati LLC.

**STEREO MODE**
Enable this setting to render frames for stereoscopic 3D.

**RESOLUTION AND QUALITY**
The resolution can be configured to an arbitrary size, however not larger than what is supported by the graphics hardware on the rendering computer. Normally, on computers with modern graphics cards, this is 4096x4096 pixels, or in some cases 8192x8192 pixels.

**FIELD OF VIEW**
If Simple render mode is selected, you will only be asked to specify the vertical field of view. Uniview will use the aspect ratio of the horizontal and vertical resolution to calculate the horizontal field of view.
**Advanced** render mode gives you the possibility to individually specify the left, right, up and down values for the field of view.

Note that if we have selected **Omnimap** render mode, the Field of View section is disabled since Omnimap renderings are always 360x180 degrees.

**ORIENTATION**
The orientation is used primarily when rendering multi-channel frames. The orientation defines how the Uniview virtual camera should be oriented, and should correspond to the setup of the projectors in, for example, a dome.

**Output**
At the bottom of the dialog, you will be able to specify the output filenames for the frames to be rendered. Since Uniview will create multiple files (one per frame), a template filename is used to describe the naming convention for the files. This can be found in the field **Filename Template**.

**OUTPUT FOLDER**
By default, the frame will be placed in the folder `<User Folder>\Frames\<Sequence Name>`, but this can be changed to other locations by editing the path or by using the browse button to the right of the text field.

**OUTPUT FILENAME**
The filenames for the frames to be created is also specified in the **Filename Template** field, and by default it will be `frame_%FRAME%.png`. When you make changes to the Output format, you will notice how the extension of the filename changes accordingly. `%FRAME%` is a placeholder and when the actual frames are being created, this part will be replaced by the actual frame numbers.

The field **Example Output** will display an example of what an actual file will look like when it is saved to disk.

**RESET FILENAME TEMPLATE**
If you want to reset the filename template to the default, as suggested by Uniview, select **Reset Filename Template...** in the **Configuration** menu at the top of the dialog window.

**Rendering**
Start the rendering by clicking the Render button. Once started, the Uniview Theater window will change to display what is being written to file for any single frame. In some cases, primarily when using the **Omnimap** render mode, what is shown on-screen may vary from what is being rendered to file. A control window will display how far the render process has progressed. In the same window you will find the button **Abort Rendering** which lets you abort the rendering process, as well as the button **Show Files...** which will open the folder where the files are created so that you can check the results.
**Render Setting Presets and Load/Save Configuration**

In the *File* menu at the top of the dialog window, it is possible to load or save the current configuration. This is useful if you plan to make several renderings of the same sequence. In the same menu you will also find the option *Load Preset*.... This option will let you choose between common output formats, such as 720p or 1080p, and all the render settings will be properly filled when one of these is selected.
HUD DISPLAY

Overview

The HUD, Heads-Up Display is a configurable display area capable of showing information on the dome. The HUD can be positioned on up to five concurrent locations on the dome and may be interacted with in run-time. It can display the following type of information:

- **Local time**
  The *Simulation time* plus the time offset set by the HUD property (more detail in the run time syntax documentation). Initially the time offset is zero and the *Local time* is same as simulation time.

- **Simulation time**
  The time according to Uniview, used for the display of the universe.

- **Date**
  The date of the current Uniview simulation.

- **Target name**
  The camera’s target, the object it is set to zoom in and out of.

- **Distance**
  The distance to the surface of the target.

- **Speed**
  The speed the observer currently is travelling with.

This information is easily displayed in a number of variations. Formats, layouts, colors and units may be changed dynamically.
How to Configure
This section discusses how to configure the start-up look of the HUD.

All HUD settings are found in a text file in your Uniview directory. Please look for the following file on your Uniview GUI computer:

<System Settings Folder>\init\XX-HUD.conf

Example: c:\ProgramData\SCISS\Uniview Theater x.x\System Settings\config\init\20-HUD.conf

Open the file with a text editor such as Notepad. It should look something like this:

```
# prefix makes all following commands
PREFIX.command
prefix HUD
prop.enabled false
prop.size 0.20
prop.alpha 0
prop.alpha 1.5
prop.rotation 0 20 0

# empty prefix resets to normal
prefix

HUD_Distance_to_Target.prop.offset 0 -1.25
HUD_Current_Speed.prop.offset 0 -2.5
HUD_Local_Time.prop.offset 0 3.75
HUD_Simulation_Time.prop.offset 0 2.5
HUD_Simulation_Date.prop.offset 0 1.25
HUD_Target_Name.prop.offset 0 0
```

First we will go through the configuration file as it looks above and explain what each line does. Then we will go through the additional settings that you may use to further customize your HUD display.

**prefix HUD**
This is the equivalent of writing "HUD." at the beginning of the following rows.

**prop.enabled {true | false}**
Controls the visibility of the HUD. Setting it to true means it is visible, and false not.

**prop.size {s}**
Controls the size of the HUD as a whole.

**prop.alpha {0<=a<=1} [timeInSecs]**
The first parameter is the transparency of the HUD, 0 is totally transparent, 1 is totally opaque.
The second parameter is the time it will take, in seconds, to reach that value.

\texttt{prop.rotation \{longInDeg latInDeg rollInDeg\}}
This specifies the position of the HUD on the dome. The parameters are Longitude, Latitude and Roll, all in degrees.

\texttt{prefix}
This undoes the first prefix command, for the rest of the file there is no implied prefix to each line.

\texttt{\{HUD item\}.prop.offset \{xOffset yOffset\}}
Determines where on the HUD the item will be positioned. As mentioned, there are several HUD items available:

- HUD\_Distance\_to\_Target
- HUD\_Current\_Speed
- HUD\_Local\_Time
- HUD\_Simulation\_Time
- HUD\_Simulation\_Date
- HUD\_Target\_Name

A complete reference of adjustable parameters follows:

\textbf{Common Settings}
This section lists the properties that can be modified to change the appearance of the HUD display:

<table>
<thead>
<tr>
<th>Property name</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HUD.prop.enabled</td>
<td>{true</td>
<td>false}</td>
</tr>
<tr>
<td>HUD.prop.alpha</td>
<td>{0&lt;=a&lt;=1}</td>
<td>The transparency of the HUD, 0 is totally transparent, 1 is fully opaque.</td>
</tr>
<tr>
<td></td>
<td>{timeInSecs}</td>
<td></td>
</tr>
<tr>
<td>HUD.prop.size</td>
<td>{s}</td>
<td>The size of the HUD, will scale the HUD’s items as well.</td>
</tr>
<tr>
<td></td>
<td>{timeInSecs}</td>
<td></td>
</tr>
<tr>
<td>HUD.prop.rotation</td>
<td>{longInDeg latInDeg rollInDeg}</td>
<td>Positions the HUD on the dome. The parameters are Longitude, Latitude and Roll, all in degrees.</td>
</tr>
<tr>
<td></td>
<td>{timeInSecs}</td>
<td></td>
</tr>
<tr>
<td>HUD.prop.clone_enabled_{1&lt;=num&lt;=4}</td>
<td>{true</td>
<td>false}</td>
</tr>
<tr>
<td></td>
<td>{timeInSecs}</td>
<td></td>
</tr>
<tr>
<td>HUD.prop.clone_rotation_{1&lt;=num&lt;=4}</td>
<td>{longInDeg latInDeg rollInDeg}</td>
<td>Positions a clone (copy) of the HUD on the dome. The parameters are Longitude, Latitude and Roll, all in degrees.</td>
</tr>
<tr>
<td></td>
<td>{timeInSecs}</td>
<td></td>
</tr>
</tbody>
</table>

\footnote{Optional parameter that make the value interpolate to the desired value in said time}
**Common HUD Item Settings**

This section lists the properties that are common to all HUD items. I.e. you can use the commands in the table below to change the appearance of any of the following six HUD items.

- **HUD_Distance_to_Target**
- **HUD_Current_Speed**
- **HUD_Local_Time**
- **HUD_Simulation_Time**
- **HUD_Simulation_Date**
- **HUD_Target_Name**

<table>
<thead>
<tr>
<th>Property name</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>{HUD Item}.prop.enabled</code></td>
<td>{true</td>
<td>false}</td>
</tr>
<tr>
<td><code>{HUD Item}.prop.alpha</code></td>
<td>{0&lt;=a&lt;=1} [timeInSecs]¹</td>
<td>The transparency of the item, 0 is totally transparent, 1 is fully opaque.</td>
</tr>
<tr>
<td><code>{HUD Item}.prop.size</code></td>
<td>{s} [timeInSecs]¹</td>
<td>Size of the individual item in the HUD</td>
</tr>
<tr>
<td><code>{HUD Item}.prop.color</code></td>
<td>{0&lt;=r&lt;=1 0&lt;=g&lt;=1 0&lt;=b&lt;=1} [timeInSecs]¹</td>
<td>Sets the color of the text and icon</td>
</tr>
<tr>
<td><code>{HUD Item}.prop.offset</code></td>
<td>{xOffset yOffset}</td>
<td>Positions the item relative to the HUD</td>
</tr>
<tr>
<td><code>{HUD Item}.prop.alignment_horizontal</code></td>
<td>{-1</td>
<td>0</td>
</tr>
<tr>
<td><code>{HUD Item}.prop.alignment_vertical</code></td>
<td>{-1</td>
<td>0</td>
</tr>
<tr>
<td><code>{HUD Item}.prop.rotation</code></td>
<td>{longInDeg latInDeg rollInDeg} [timeInSecs]¹</td>
<td>Positions the item relative to the main HUD rotation, usable for flat domes</td>
</tr>
</tbody>
</table>

¹ Optional parameter that make the value interpolate to the desired value in said time

**Specific HUD Item Settings**

Finally, this table lists the settings that are available for specific HUD items only:

<table>
<thead>
<tr>
<th>Property name</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
</table>
### Changing Settings During Runtime

All the properties mentioned above can easily be modified during run-time as well as in the configuration file. The syntax is the same and all that is needed is to assign the actions to different buttons in the Custom Events window of Uniview. Just click the star icon to bring up the Custom Events window and right-click the button titled "<Unassigned>" to create a new button. Enter a name for the button, and then enter one or several commands that should be triggered when the button is pressed. See the section *Customizing the GUI* for more information.
Examples of Custom Button Configurations

Button that...

- fades on the HUD whilst sliding it into view:
  
  ```
  HUD.prop.alpha 0;
  HUD.prop.enabled true;
  HUD.prop.alpha 1 2;
  HUD.prop.rotation 0 0 0 2;
  ```

- fades off the HUD whilst sliding it out of view
  ```
  HUD.prop.alpha 0 2;
  ```

- turns off the HUD (as the previous stills leaves it on but faded)
  ```
  HUD.prop.enabled false;
  ```

- highlight the simulation time
  ```
  HUD_Simulation_Time.prop.color 1 0.5 0;
  ```

- removes any highlight by fading all text to white:
  ```
  HUD_Distance_to_Target.prop.color 1 1 1 2;
  HUD_Current_Speed.prop.color 1 1 1 2;
  HUD_Local_Time.prop.color 1 1 1 2;
  HUD_Simulation_Time.prop.color 1 1 1 2;
  HUD_Simulation_Date.prop.color 1 1 1 2;
  HUD_Target_Name.prop.color 1 1 1 2;
  ```

- aligns all HUD-items to the left:
  ```
  HUD_Distance_to_Target.prop.alignment_horizontal 1;
  HUD_Current_Speed.prop.alignment_horizontal 1;
  HUD_Local_Time.prop.alignment_horizontal 1;
  HUD_Simulation_Time.prop.alignment_horizontal 1;
  HUD_Simulation_Date.prop.alignment_horizontal 1;
  HUD_Target_Name.prop.alignment_horizontal 1;
  ```

- aligns all HUD-items to the right:
  ```
  HUD_Distance_to_Target.prop.alignment_horizontal -1;
  HUD_Current_Speed.prop.alignment_horizontal -1;
  HUD_Local_Time.prop.alignment_horizontal -1;
  HUD_Simulation_Time.prop.alignment_horizontal -1;
  HUD_Simulation_Date.prop.alignment_horizontal -1;
  HUD_Target_Name.prop.alignment_horizontal -1;
  ```

- aligns all HUD-items to the center:
  ```
  HUD_Distance_to_Target.prop.alignment_horizontal 0;
  HUD_Current_Speed.prop.alignment_horizontal 0;
  HUD_Local_Time.prop.alignment_horizontal 0;
  HUD_Simulation_Time.prop.alignment_horizontal 0;
  ```
HUD_Simulation_Date.prop.alignment_horizontal 0;
HUD_Target_Name.prop.alignment_horizontal 0;

- **zooms in** on the HUD:
  
  HUD.prop.size 0.8 2;

- **zooms out** of the HUD:
  
  HUD.prop.size 0.2 2;
# KEYBOARD SHORTCUTS

<table>
<thead>
<tr>
<th>Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>F1</strong></td>
<td>Switch to Orbit Mode</td>
</tr>
<tr>
<td><strong>F2</strong></td>
<td>Switch to Free-flight Mode</td>
</tr>
<tr>
<td><strong>F5</strong></td>
<td>Lock to Current Target</td>
</tr>
<tr>
<td><strong>F6</strong></td>
<td>Lock to Sun</td>
</tr>
<tr>
<td><strong>F7</strong></td>
<td>Lock to Stars (Release Lock)</td>
</tr>
<tr>
<td><strong>F9</strong></td>
<td>Show/Hide Tool Windows</td>
</tr>
<tr>
<td><strong>F11</strong></td>
<td>Toggle Full Screen Mode</td>
</tr>
<tr>
<td><strong>F12</strong></td>
<td>Start/Stop Recording of Camera Sequence</td>
</tr>
<tr>
<td><strong>f</strong></td>
<td>Toggle Rotational Friction</td>
</tr>
<tr>
<td><strong>F</strong></td>
<td>Toggle Translational Friction</td>
</tr>
<tr>
<td><strong>CTRL</strong></td>
<td>Enable Camera Angle Adjust (keep CTRL and left mouse button pressed and drag the mouse)</td>
</tr>
<tr>
<td><strong>HOME</strong></td>
<td>Jump to Earth</td>
</tr>
<tr>
<td><strong>SHIFT+HOME</strong></td>
<td>Fly to Earth</td>
</tr>
<tr>
<td><strong>CTRL+E</strong></td>
<td>Place the cursor in the Search all objects field</td>
</tr>
<tr>
<td><strong>CTRL+W</strong></td>
<td>Place the cursor in the Command Console field</td>
</tr>
<tr>
<td><strong>ARROW KEYS</strong></td>
<td>Start continuous rotation. Press multiple times to go faster. Click left mouse button to cancel the rotation.</td>
</tr>
<tr>
<td><strong>PAGEUP</strong></td>
<td>Start continuous translation. Press multiple times to go faster.</td>
</tr>
<tr>
<td><strong>PAGEDOWN</strong></td>
<td>Stop any rotation/translation started by arrow keys or pageup/pagedown.</td>
</tr>
<tr>
<td><strong>END</strong></td>
<td>Stop any rotation/translation started by arrow keys or pageup/pagedown.</td>
</tr>
<tr>
<td><strong>t</strong></td>
<td>While dragging the time jog shuttle, press “t” to set the simulation speed to the current value when shuttle is released.</td>
</tr>
<tr>
<td><strong>.</strong></td>
<td>Press “.” in the command console to insert the name of the currently selected object in the Object Tree tool window.</td>
</tr>
</tbody>
</table>